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1 Introduction

Welcome to Boardmaker Studio, the future of the Boardmaker Software Family! Equipped with an extensive collection of
powerful templates, an efficient new user interface, and a host of time-saving tools, Boardmaker Studio gives you what you need
to meet your students’ needs quickly.

= Easy to Learn and Use - An intuitive new interface, simple page management, and
starter templates organized the way you think.
= Create Engaging Activities Fast - Over 600 powerful and easy-to-use starter tem-
plates and more than 125 Gadgets means fast solutions for your students.
= A Fresh Spin on an Old Favorite - Import your Boardmaker Version 5 and 6 boards
and use Boardmaker Studio to edit, print, and share them.
= Seamless Integration with BoardmakerOnline.com - Download your online files
for fast, efficient editing in Boardmaker Studio. You can work offline and then sync
your files when you're back online!

Boardmaker. Studio

1.1 How to Get Additional Help

This document is an introduction to the basic skills you will need to create fantastic projects using Boardmaker Studio. It is de-
signed to get you up and running quickly and to serve as a reference guide. You may even want to print this document to have
on hand while you are getting familiar with the software.

Select Help in the upper right corner of the Dashboard to access the comprehensive Boardmaker Studio User's
Manual, online videos, and tutorials.

Boardmaker Studio Getting Started v.1.0 - en-US 1 Introduction | 5



2 Getting Started

The first time you launch Boardmaker Studio, you will be prompted to register. You will only need to complete the registration
process once.

2.1

6

Register Boardmaker Studio

On your desktop, double-click the &

Boardmaker Studio shortcut.

Read the Boardmaker Studio End User License Agreement that appears, and select Accept.

Welcome To Boardmaker Studio

Select Register.

@ Boardmaker. Studio

1. Welcome 2 Register 3. Finished!

Welcome To Boardmaker Studio

To start using the full version of the software, you will
need to register the program using a Product ID.

Run As Trial

Ifyou do not have a Product ID, you
can run the software as a30-Day

Trial. Aninternet connection is
required. Ifyou wish to run a trial, but

you do not have an intere

connection please call 412-381-4883

to getatral key

n If you select Run As Trial, you will be able to use Boardmaker Studio without a product ID for 30 days.

Register

@ Boardmaker. Studio

Register

*Product ID:
*FirstName:
*LastName:

Emal
Organization:

Computer Name:

1. Welcome 2 Register 3. Finished!

|
]
]
|
]

DVOXLAP-0000611

Register GoBack

Please enter the information requested below to begin the registration process. f you have a
valid Internet connection, registration will take place automaticaly, otherwise, you will be
presented with options for manual registration

Cancel

Select Register. Boardmaker Studio is registered.
Select Close. Boardmaker Studio will open automatically.

| 2 Getting Started

Enter your Product ID, First Name, Last Name, email address, and Organization name.
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2.2 Open the Designer

After registering Boardmaker Studio, you can start working with a project in

the designer quickly:

= Select New... to create a new blank project or a new template-based

project.

= Select Open... to open an existingBoardmaker v5/6 or Boardmaker

Studio project in the Designer.

B
H seNe
AN 87

2.3 Access Content from BoardmakerOnline.com

n To sign in or create a new BoardmakerOnline.com account, you must have an active internet connection.

If you already have a BoardmakerOnline.com
account:

1. Select Log In.

O

Getting Started  Help | Login Q

If you do not yet have a BoardmakerOnline.com
account:

1. Select Log In.

O

Getting Started  Help | Login Q

2. To log into your account on BoardmakerOnline.com, enter
your email and password, then select Log In.

Tobii Dynavox Single Sign Or

Log in to your account

Wihat is & Tobi Dynavos account?

Forgot your password?

7

3. Select My Boardmaker. =

Boardmaker Studio Getting Started v.1.0 - en-US

2. Select Create Account.

Tobii Dynavox Single Sign Or

Log in to your account

What is a Tobs Dynavos account?

3. Enter and submit the required information. A confirmation
email will be sent to the email address you provided.

4. Open the confirmation email and click the confirmation
link.
5. (In Boardmaker Studio) Select Log In.

4

6. Select My Boardmaker. "

2 Getting Started |
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3 Boardmaker Studio Basics

The Boardmaker Studio software consists of two main interfaces: Dashboard and Designer.

3.1 Dashboard

% Boardmaker Studio — [m]

Boardmaker, Studio GettingStarted  Help Jean LogOut Q

Search My Recent Activities on this Computer Q ‘

@ All Activities

{]

On This
Computer

Q

My Boardmaker

Game Comment

10/17/2018, 3:42 PN

aily activities fruit and veg Counting bills a...
1:22 P 10132018, 1207 P 073/ 524N

The Dashboard is the first screen that appears when you open Boardmaker Studio. It gives you quick access to activities stored
on your computer and on BoardmakerOnline.com, as well as buttons for the most common Boardmaker Studio tasks.

The Dashboard bridges the gap between Boardmaker Studio and BoardmakerOnline.com. From the Dashboard, you can
quickly search for your activities that are stored locally or in your My Boardmaker account online and edit them in Boardmaker
Studio.

3.1.1 Dashboard — On This Computer

Activities found in the On This Computer section of the dashboard are Boardmaker Studio files stored locally on your computer
only; they are not currently shared to your BoardmakerOnline.com account. These activities are available to play or edit in
Boardmaker Studio any time.

To make an activity available on BoardmakerOnline.com, just mouse over the activity and select Move. After a brief conversion
process, the activity will be available on BoardmakerOnline.com and in the My Boardmaker section of your Boardmaker Studio
Dashboard.

n You must have an active internet connection and be signed in. See section 2.3 Access Content from BoardmakerOn-
line.com.

8 | 3 Boardmaker Studio Basics Boardmaker Studio Getting Started v.1.0 - en-US



3.1.2 Dashboard — My Boardmaker

% Boardmaker Studio - a

Boardmaker. Studio Getting Started  Help Jean LogOut Q
I:I Search My Activiies on Boardmaker Online Q ‘
Al Activities

On This
Computer

Folders (1)

N

My Boardmaker

Rocks- Science/P...

Activities (1)

+_) Refresh

Hidden Picture -...

Figure 3.1 Dashboard — My Boardmaker, All Activities view
Activities found in the My Boardmaker section of the dashboard are files that are available on your BoardmakerOnline.com
account.

= Folders that exist on BoardmakerOnline.com will also appear in your My Boardmaker section, All Activities view. Select a
folder to browse the activities inside.

e Activities with the icon are available on BoardmakerOnline.com as well as on your computer. These activities are
ready to play or edit in Boardmaker Studio any time, even if you're offline. Changes that you make to these files in Board-
maker Studio are synced to the file on BoardmakerOnline.com the next time you have an internet connection.

e Activities with the . icon are on BoardmakerOnline.com only, so you can't yet work with them in Boardmaker Studio
or access them while you're offline. To make these activities available to play or edit in Boardmaker Studio, simply hover
over the activity and select Download. After a brief conversion process, the activity will be available to play or edit.

T

DOWNLOAD

You must have an active internet connection and be logged in. See section 2.3 Access Content from Board-
makerOnline.com.

Boardmaker Studio Getting Started v.1.0 - en-US 3 Boardmaker Studio Basics | 9



3.2 Designer

% Boardmaker Studio - health stamp

= O
File Edit Getting Started Help  Go To Dashboard Q
= 1
3 heath stamp Bugon
& (x) LAamping
Type ¥
7 Stamping . - OB hd
H 3 )
‘? Place a background picture in this box Content F3
_ popup - confirm clear all Ad Q: z
G. JFrat E
-~
£
dBc
E
Margin |0 2
Background >
Fort ¥
Style ¥
Style Ovenide ¥
State ¥
Programming ¥
s e TS Drag and Droz ¥
to be used - ’ ) to be used
CProject = shljn'\ps L as Mo v
nto the boxes 3
—~ N Print | tbop
G-‘ Symbols above i 4 ELL
# Gadgets s 5 ]
Type to set the button's label. <Alt> Drag to copy. |7 object selected [0 v:0 W:1.07 H: 1.04 |FE B 69% - Q) ] (O

The Designer is the primary workspace where you will create, edit, preview, and play your projects.

10 | 3 Boardmaker Studio Basics Boardmaker Studio Getting Started v.1.0 - en-US



3.3 Essential Tools and Elements

3.3.1 Designer

& |k OB 3B IN|A| L =S| Q.| D>

Symbol Select Button Freeform Spray Line Label Symbolate Message Scan Zoom Advanced Play

7 Project1

- p
@

@_I Symbols
a o

Gadgets = 7
o I |EE 5% -Q ol ay
1 Toolbar Contains the File Menu, Edit Menu, Undo and Redo, editing, design, and drawing tools.
2 Go to Dashboard Close current project and go to the Dashboard.
3 Properties Pane Displays the properties/controls of the current panel.
4 Designer workspace | Area in which you create and edit your page(s).
5 Navigation buttons Opens the Project, Symbols, and Gadgets panels.
6 Page tabs Access each open page in the workspace.
7 Zoom controls Adjust the view of the workspace.

Boardmaker Studio Getting Started v.1.0 - en-US 3 Boardmaker Studio Basics | 11



Getting Started  Help  Go To Dashboard Q

Freeform

0 0000000 O

1 Symbol Open the Symbol panel to search the symbol library and add symbols the page.

2 Select/Quick Select | Select objects on the page, or select the page itself.

3 Button Create a standard button, group button, Word Predictor, Target, or Hotspot.

4 Freeform Create a freeform button or Hotspot.

5 Spray Spray out copies of a selected object into a rectangular or circular grid.

6 Line Draw a horizontal, vertical, or diagonal line.

7 Label Create a new text label.

8 Symbolate Create a symbolate button.

9 Message Create a Message Window.

10 Scan Order Tool Set the order in which the objects on the page will be scanned.

11 Zoom/Pan Select the Zoom tool and click anywhere on the page to zoom in. Select the Pan tool to move
the page in any direction.

12 Advanced Enhance the page with added video, group boxes, checkboxes, radio buttons, textboxes, and
tab controls.

13 Play See how your page or project works: enter Play mode, Play Full Screen, or Preview Page.

3.3.3 Project Panel

The Project panel displays the activities and pages in the currently open project. (See section 3.3.8 Project Organization, page

15)

12

Ceeget
Q Symbols

! Gadgets

| 3 Boardmaker Studio Basics

_ Projectl

o

2 Activity 1

E Picture Graph
D .

B B € R TN

& (x)

& (x)

(x)
& (x)

& (x)

1 Project folder | Top level (project-level) folder.

2 Macro and
shared varia-
bles icons

Indicates there are shared macros and shared variables. (In this in-
stance, they are at the project level.) Select either icon to view and edit
their respective values.

3 | Pages Thumbnails of each page within the activity or project. Icons appear on
the right if there are any shared macros and/or variables at the page

level. Double-click a page icon to open the page.

4 | Activity folders | Activity-level folders. Select the double arrow to expand or collapse
the folder pages view. (Note that this activity contains shared variables

at the activity level.)

5 | Floating
toolbar

Displayed when you mouse over the project folder, a page, or an activ-
ity. The floating toolbar contains tools for editing the project/activity/
page, for printing, and for editing shared variables and macros.

Boardmaker Studio Getting Started v.1.0 - en-US



3.3.4

Properties Panel

Use the Properties panel to assign properties (label, actions, symbols, shape, style, etc.) to an object or to a page or to multiple
selected objects. Whenever an object - or the page itself - is selected, its Properties panel will open.

n The Properties groups will differ depending on the object selected. The Button Properties panel is illustrated here.

Type 2
Type | Standard w
Content H

EER P SN

— —~ o
| Q) | 22
o ARC

Margin |0 =

+
-| sBCw
+

»

Background

k;'

Fort

»

Tahoma V(12 v

A& B I|U
A [

Style

D,

Style Overidz

»

>

| [ [~

>

Siate

[] Disabled [ Hidden
Selectable [ ] Locked

Progranming ]
Objec: Name  rowlabel_1 ~
=dt Actions -
Drac and Jrop ]
Drzg Type | Nore ~
Mscellaneous -
Audio Cue  actumn
Maintan Aspect  Yes ~
Clip Corrert  Fi ~
Horizortal Alignm | ot i
Vetical Micnmert  Top ~

£
Use the pin button to collapse the Properties Panel out of the
way if you don't want to see it. The pinned Properties Panel can be
brought back into view by selecting the vertical Properties button on the
right side of the designer window.
Type Change the button type:
=  Standard
= Symbolate
= Word predictor
= Group
Content Enter, format, and justify the button label text.
Search for and place a symbol on the button.
Edit the symbol.
Choose the symbol and/or label layout.
Additional formatting can be done using the Rich Text Editor. For more
information see section 72 Rich Text Editor.
Background Choose a background symbol for the button.
Font Choose a font family, size, and style for the label text. Change the color
of the font, and select a background color for the text.
Style Change the button's appearance with pre-formatted styles.
For more information see section 74 Changing an Object'’s Style.
Style Override Customize the button’s shape, fill color, and border. For more informa-
tion see section 714 Changing an Object’s Style.
State Disable, hide, lock the button, or make it not selectable.

A locked object is not selectable by left click in Design mode;
its behavior in Preview or Play modes is not affected.

Programming

Assign a unique name to the object (for programming purposes). Add
or edit actions to program the button.

For more information see section 16 Working with Actions.

Drag and Drop

Choose what happens when you click and drag this button in Play
mode:

= nothing (None)
= move the button
= make a draggable copy of the button

Miscellaneous

Type a short message that plays when the cursor or scanning highlight
moves over the object in Play mode.

Determine whether, when the button is resized, the contents of the but-
ton will scale (maintain aspect), and whether the symbol will fill, fit, or be
clipped to fit in the resized button.

Boardmaker Studio Getting Started v.1.0 - en-US
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3.3.5

Symbols Panel

The Properties panel offers dynamic tools relevant to the currently selected object in the workspace. All of the proper-
ties panels are described in detail in the Boardmaker Studio User's Guide.

SmartSyms are symbol/label pairs that behave as a single object. You can place a SmartSym directly on a page, on an object
on a page, or use a SmartSym as the page background. SmartSyms can also be assigned actions.

Use the Symbols panel to search for a SmartSym, choose its label, and then drag it onto an object (or onto the page itself). You
can easily add new symbols to objects, replace symbols, and choose whether symbols will appear with or without labels.

SmartSyms have their own properties, unless you place them on a standard or freeform button - then they become
part of the button. Only one symbol at a time can be placed on a standard or freeform button.

halllc 4] N5

-

D riF P =

P4 x el
¥ | o |

—
e

~
v

More |=#
'; Project
"G [Symbols
! Gadgets

3.3.6

Gadgets Panel

1 Back arrow Move backward through the browsing history in your sym-
button bol search.
Home button Displays the top level of symbol category folders.

3 Search text Enter your search criteria in this field.

box

4 Symbol search | Search for items that match the search criteria entered in

button the Search text box.

5 Symbols and Provides quick access to label and search language set-

Language tings and symbol preferences.
button

6 Preview area Dynamically displays the selected symbol. Drag-and-drop
the symbol from the preview area into the workspace.

7 Label drop- Displays the label(s) for the currently selected symbol.

down (Some symbols have more than one label). Use the drop-
down menu to display alternate labels. You can also enter a
new label in the text field of this menu.

8 Include label Select this box to display a label with the symbol. (Dese-

check lecting the check box will disable the text box, and no label
will be displayed or included when you drag the SmartSym
into the workspace.)

9 Symbol Displays the symbol search results or category folders

options while browsing. Drag-and-drop any symbol from here into
the workspace.

10 | Scroll bar Appears when the number of available symbols exceeds
the display space. Move the scroll bar left and right to dis-
play more symbol choices.

11 | More button Select this button to expand the symbol options area and

view more symbols at one time.

Gadgets are pre-programmed objects and groups of objects you can use to construct or enhance on-screen activities. Use the
Gadgets panel to browse through the gadgets and add them to your pages. The gadgets are organized into categories and
subcategories.

For more information about the gadgets and how to add them to your pages, see section 15 Working with Gadgets.

14

| 3 Boardmaker Studio Basics

Boardmaker Studio Getting Started v.1.0 - en-US



1 Search Box To search for a gadget, enter your search term, then select the

o :

+ &P | search & Search icon
o Keyboards = 2 Categories Double-click a category folder to open it and browse the gadgets
and subcategories inside.
e 3 | Gadgets To place a gadget on the page, select the gadget and drag it onto
the page.

word Prediction

riting Grids

Writing Windows

ABC ChangeWord Button
Ags * Opens a window to change

ABD 5 the word at the current cursar

Check 5 pelling B utton
Opens the speling checker
ABC and checks the spelling of the

Clear MessageWindow Bu
Deletes all of the content in 5
] message window.
*| Insert Symbol Button

Inzerts the button's spmbol
inta the message windaw,

=

= e D
More |=*

[ Project
G Symbals

| Gadgets

3.3.7 Boardmaker Studio Software Modes

In Boardmaker Studio, you will use the following modes:

= Design mode is the default mode in the Designer. It enables you to edit and create your learning activities by building
and adding content to projects, activities, and pages.

= Play mode enables your users to play an activity in a program window. When you select Play mode, the project will play
from the first page (not necessarily the page that is open).

= Play Full Screen mode plays the activity in a program window that fills the screen.

= Preview Page mode enables you to test your activities. When you select Preview Page mode, the current page will be
displayed as the user would see it.

When you are in Play or Preview mode, use the Stop button or <Esc> key on your keyboard to return to Design
mode.

3.3.8 Project Organization

In Boardmaker Studio, you will work with three different components: projects, activities, and pages.

= Projects are collections of pages that you can use as a group. You can think of a project as a book that contains chap-
ters and pages.

= Activities are collections of pages within a project. They are represented as folders, and you can use them to categorize
related pages in a project into separate learning activities. In this way, activities are like chapters in a book. Just as a
chapter in a book can contain sections and subsections, an activity can contain other activities.

= Pages are the fundamental components of projects and activities. Boardmaker Studio pages are like the pages of a
book - they contain the content that the users will read (or interact with). In Boardmaker Studio, this content consists of
objects such as buttons, message windows, symbols, and so on.

Boardmaker Studio Getting Started v.1.0 - en-US 3 Boardmaker Studio Basics | 15



4

Templates

A template is a page or a set of pages that has been designed for a specific type of activity. You can create new projects, activ-
ities, and pages based on templates.

When you create a new project, activity, or page based on a template, the template page(s) are copied into your new project/
activity/page and you can then adjust the content however you wish.

Templates are available for the following types of activities:

4.1

Art and Creativity - Develop creativity and artistic expression.

Books and Presentations - Develop reading skills and present new information.

Calendars - Review upcoming events and develop mathematical and time-based skills.

Classroom Routines - Templates for daily attendance and student sign-in.

Communication and Participation - Communication displays to help users participate at home, at school, and at ex-
tracurricular activities.

Device Overlays - Create overlays for a wide range of digitized communication devices.

Explore - Explore new information, pictures, and symbols through errorless activities.

Flashcards - Build and master vocabulary.

Games - Reinforce concepts and knowledge in fun and engaging formats.

Graphic Organizers - Create cycles, list maps, storyboards, trees, and webs to visually display relationships.
Labeling - Label the parts of the whole.

Matching - Match words to related pictures or items.

Mathematics - Build mathematical skills in areas such as counting, patterns, money, and graphs.

Question and Answer - Reinforce and assess knowledge in a given area.

Sequencing - Sequence items in the correct order.

Sorting - Sort items into two, three, or four groups.

Visual Schedules and Sequences - Introduce and review daily events and planned transitions.

Word Study - Develop knowledge of letters and their corresponding sounds, and understanding of how groups of let-
ters and sounds make words.

Writing - Develop beginning composition and syntax skills.

Sample templates (indicated by the word SAMPLE at the end of the name) are available as fully populated demo files.
You can use them to see how a template works and how to use it instructionally.

Many of the onscreen templates can also track student performance and report back results when the activities are
used by students in a Boardmaker Online subscription account. These “performance enabled” templates are indi-

@

cated by a icon.

Create a New Project from a Template

Creating a new project from a template is the quickest and easiest way to make new activities for your students.

1.
2.
3.

4.2

From the Dashboard, select New.... The New Project window opens.

Select a template from the list of templates.

Select Create to create the project. The pages that are included in the template are added to the project, and will ap-
pear in the Project panel.

Create a New Activity from a Template

When you create a new activity from a template, a folder is added to the currently open project, and all of the pages included in
the template are added to the activity.

1.

2.
3.

16

In the Project panel, mouse over the project folder.

In the floating toolbar, select the —1 New Page/Activity icon.

Select Activity....
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The New Activity window will open.

n You can also right-click the project, then select New > Activity...

4. Select a template from the list.

5. Select Create. The activity folder is created.
The pages that are included in the template appear in the activity’s folder in the Project panel. To view these pages, dou-
ble-click the activity folder.

4.3 Create a New Page from a Template

When you create a new page from a template, the first page of the selected template is added to your project.

1. Inthe Project panel, mouse over the page after which you want to insert the page.

2. Inthe floating toolbar, select the —1
3. Select Page from Template.

The New Page window will open.

New Page/Activity icon.

4. Select a template from the list of templates.
5. Select Create.
The page is created and will appear in the Project panel.
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5 Creating a New Page

If you want to create a new page in your project that isn't covered by one of the templates, then you can create a new blank
page.

To create a new page at the end of the project
1. Select File > New > Page.

Edit ? E

‘ Mew » Project...

5 ore :

Recent Projects ' Page from Template...

Close and Go To Dashboard |

To create a new page after an existing page

1. Mouse over the existing page in the Project Panel.
2. Select the New Page/Activity icon in the floating toolbar.

"y Page 2

:f'\_@«'jé‘ (x)

3. Select Page. The new page is created below the page selected in step 1.

You can also create a new page based on an existing page in the project. Select Like Page, then choose a
page from the list.
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6 Converting Boardmaker v5/v6 files

You can convert boards, board packages, and .zip files that were created in Boardmaker version 5 and above and save them as
new projects to edit in Boardmaker Studio.

1. Select the Open... button on the Dashboard screen.

In the file browser window that opens, select the file type drop down menu and choose Boardmaker v5/v6 Files (*.
bm2, *.zbp, *.zip).

2.

3. Navigate to the directory containing the desired file.
4. Select the .bm2, .zbp, or .zip file you would like to import.
5. Select Open. The Boardmaker Conversion Setup dialog will open.

Boardmaker Conversion Setup

New Project Name:

Browse
Boardmaker Boards
fruit and veg bm2

Reselect Boards Add Related Boards

Conversion Wamings

Show only critical conversion wamings v

Conversion Fidelity

Favor editability over visual fidelity ~

Symbolate Fidelity
Keep symbolate buttons as symbolate buttons ~

Cancel

n Select Reselect Boards to return to your file folder to re-select or add boards.

6. (Optional) Select Conversion Warnings, Conversion Fidelity, and Symbolate Fidelity settings from the drop-down lists.
7. Select Import. The project is saved as a new Boardmaker Studio activity file and opens in the Designer.

If you have selected Show All Conversions Warnings in the Conversion Setup Dialog, the Conversion
Warnings dialog will open, stating that the files have been successfully converted and listing any inconsisten-
cies in the conversion process. Select OK to close the Conversion Warning dialog.
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7.1

Drawing Page Objects

Select the tool for the object you want to draw. See section 3.3.2 Toolbar to learn about the object tools in the toolbar.
Move the cursor into the workspace where you want to place the object.
Click and drag diagonally. (To draw a square object hold down the Shift key while dragging.)

To re-size the object:

a. Select the object.
b. Move the cursor over any edge or corner of the object until a double arrow appears.
c. Click and drag the edge or corner until the object is the desired size.

To move the object:

a. Select the object.
b. Drag it to any position in the workspace.

Quickly add an object to a page by clicking on the tool, then dragging onto the page - or by selecting the tool
and then clicking on the page.

Use the object’s Properties panel to customize the appearance, programming, and behavior of the object. (The options
in the Properties panel will vary depending on the type of object you have drawn.)

Creating a Grid of Objects

] ] 0
=90 a-o

You can create a rectangular or circular grid of identical objects using the SprayToolor =  Circular Spray Tool.

1.

3
4.
5.

Select the triangle beside Spray Tool in the toolbar.
Select:

= Spray Tool to create a rectangular grid.
= Circular Spray Tool for a circular grid.

Position the cursor over the object you would like to duplicate.
Click and drag diagonally to create a grid of identical objects.
Release the selection when the grid is the desired size.

You can reposition the grid while the grid objects are still selected (they will have dotted outlines). Click and drag any
selected object to reposition the entire grid.

If you have assigned properties to the original object (symbol, style, actions, etc.), they will be copied to the other ob-
jects in the grid.
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8 Working with Buttons

Buttons are the most commonly used objects on pages. Select the triangle beside the Button Tool to access all of the fol-

lowing button types:

= Standard (rectangular) Button - these are the basic building blocks. They accept a single SmartSym and a wide variety

properties (style, programming, etc.).

= Group Button - can contain multiple symbols or other objects.

= Symbolate Button - as the user types each word into a symbolate button, the symbol for the word automatically
appears.

=  Word Predictor Button - as the user types into the message window, the Word Predictor button anticipates the user’s

word choices.
= Target Button - a group button that has been pre-configured as a destination for a draggable button.
= Hot Spot - an invisible button that is usually placed over images on a page.

n You can also draw Freeform Buttons and Freeform Hot Spots via the Freeform Tool.

8.1 Adding a Symbol to a Button - “Edit in Place”

One of the more exciting features of Boardmaker Studio is the “edit in place” feature. This is the easiest way to quickly place text

and a symbol in a standard or freeform button.

1. Draw a standard or freeform button in the workspace.
2. While the button is still selected (has a dotted outline), type the desired label. The label will appear in the button.
3.  When you are finished typing the label, hit Enter on your keyboard.

The Open Symbol window will appear.

Open Symbol - o x

@ Search @ view

Q & s M

Nane

From Fie. oK Cancel

Symbols matching the label text you have entered are displayed.

4. Select the desired symbol.
5. Select OK or double-click the symbol. The selected symbol appears on the button.

8.2 Working with Group Buttons

A group button is a button into which you can place other objects - it acts as a “container” for other objects. You can place
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multiple symbols (SmartSyms) in a group button, add a label (or labels), and arrange the objects in the group button in any way
you like.

Figure 8.1 Group button (grid layout) with two buttons, a label, and a SmartSym.

When objects are placed in a group button, they retain their original properties, so each object in the group button can be re-
sized or repositioned (or programmed) individually without affecting the properties of its “parent” - the group button.

Group buttons can also be used to create scanning groups and can be designated as “targets” so that other objects can be
dragged into them.

n See the Boardmaker Studio User's Guide for more information on group button properties.

8.2.1 Create a Group Button

1. Select the Button drop-down menu in the toolbar. Then select Group Button.
2. Draw a group button anywhere on the page. See section 7 Drawing Page Objects.

You can also use the Type menu in the button Properties panel to transform a standard, symbolate, or word predictor
button into group button.
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8.2.2 Add Symbols to the Group Button

| mountain |
- - -

PSR — S 4

Figure 8.2 Group Button - Multiple Symbols Selected

—_

Search for a symbol. See section 9.7 Browsing for Symbols.
Drag a symbol from the Symbols panel and drop it onto the group button.
Repeat steps 1 and 2 to add more symbols to the group button. (You can add as many symbols as you like.)

(S

When you add a symbol to a button that already contains one or more symbols, you will be asked if want to
add to or replace the existing symbol(s). Choose one of the following:

= Add To if you would like to keep the existing symbol(s) and also add the new symbol.

= Replace if you would like to replace the existing symbol(s) with the new symbol.
= Cancel to leave the button as it is.

8.2.3 Add a Label to the Group Button
1. Draw a label in the group button. See section 7 Drawing Page Objects.
2. Enter and format the label text. See section 77 Working with Labels.
8.2.4 Resize and Reposition Symbols and Labels in the Group Button

Reposition and resize the symbols and label as needed. To resize multiple symbols, select them (Ctrl + Click to select multiple
symbols) and resize them as a group.

Layout %

o
B0
a

)
Hno

ooo
ooo
ooo

Figure 8.3 Group Button Layout drop-down menu

You can use the Layout drop-down menu in the Layout Properties group to automatically organize the contents of the
group button in different ways.
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8.3 Working with Symbolate Buttons

As you type in a Symbolate button, the symbol for the word you are typing will appear automatically.

8.3.1

1.
2.

8.3.2

Create a Symbolate Button

Select the Symbolate button in the toolbar.
Draw a Symbolate button anywhere on the page.
See section 7 Drawing Page Objects.

Select the Symbolate button.
Use the controls in the Button Properties panel to customize the Symbolate button.

n See the Boardmaker Studio User's Guide for step-by-instructions on defining all symbolate button properties.

Change the Symbolate Symbol

Boardmaker Studio uses predefined word/symbol pairings. Sometimes, the first symbol that appears may not be appropriate for
the context in which the symbol is being used. You can use the Symbolate Candidates dialog to change the symbol for that in-
stance of the word-symbol pairing or for every instance of the word-symbol pairing.

1.
2.
3.

8.3.3

Right click on the symbol (not the word) that you want to change. The Symbolate Candidates dialog opens.

Select the symbol that you would like to use.

If you only want this symbol to be used in this particular instance, select OK.

If you want the selected symbol to be the new default symbol for the word (whenever the word appears) select Make
Default.

Change the Text for a Word/Symbol Pairing

You can change the text in individual instances of existing word/symbol pairings.

1.
2.
3.

Double click on the symbol (not the word) you want to change. The Symbolate Candidates dialog opens.
In the Label text field, enter the new word or phrase for the label.

Select OK.

The new text replaces the original text for this instance of the word only.
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9 Working with Symbols

SmartSyms" are symbol/label pairs that behave as a single object. You can place a SmartSym directly on a page, on an object
on a page, or use a SmartSym as the page background. SmartSyms can also be assigned actions.

Use the Symbols panel to quickly search for a symbol (SmartSym), choose its label, and then drag it onto an object on a page
or onto the page itself.

9.1 Browsing for Symbols

*|@® CNE! Open bl
- P i Searchl:lQ View =

MNane: school school schaol schaal school

Gt
e

schaol

a A

Schoal Schodl school bag school bag school bag school bag

~
w

More |=» From Fle. . 0K Cancel

Figure 9.1 Search for “school” showing individual symbol results, category folder, and tag. The Symbols panel is shown on the left
and the Open Symbol window is shown on the right.

You can quickly and easily browse for symbols in either the Symbols panel or the Open Symbol window.

To browse from the Symbols panel:
P =N

1. Select the (-1—' " Symbols navigation button (on the left side of the designer).

2. Navigate through the layers of folders until you find the symbol you want to use or use the search field to enter a key
word (cow) or category (farm animals).
Select a category folder or tag to browse all related symbols.

The Open Symbol window appears when you “edit in place,” or when you select the Symbol Search button in the
Content Properties group for the selected object. Categories can be browsed in a similar fashion in this

9.1.1 Symbol Search Shortcuts

= Use the asterisk [*] as a generic “wildcard” character. For example, entering “mon*” in the Search text box will return all
symbols whose labels begin with the letters “mon.” Similarly, entering “*ten” will return symbols whose labels end in
“ten.”

= Use quotation marks (*) at the beginning and end of a word to return a whole word match. (For example, entering “dog”
[using quotation marks] in the Search text box will return only symbols with the exact label, “dog.”)

= Use an apostrophe () at the beginning and end of a word to return symbols whose label contains the word. (For exam-
ple, entering 'dog’ [using apostrophes] in the Search text box will return symbols whose labels include the separate

Boardmaker Studio Getting Started v.1.0 - en-US 9 Working with Symbols | 25



word, “dog,” such as “dog,” “dog bed,” “dry dog food,” etc. but not words where dog is part of a longer word, such as
“doghouse” or “Dordogne.”)

Open Symbol =

> @ 4| Search mon G | View -

O W H w ¥’

Nene  monard b monardt h o monard hbutterfly  monard

money money money hungry money hungry monitor

From Fie. oK Cancel

Figure 9.2 Wildcard Search (Example Of Search For Beginning Of Word Using “mon*”)

9.2 Setting the Symbol Label Language

Select a specific language for your symbol searches and for the label displayed with the symbols. You can use different lan-
guages for your symbol searches and for the label text.

n Changing the symbol language will not change the existing labels you have already placed on pages in your project.

1. Select File Menu > Setup and Options.
The Setup and Options dialog will open.

2. Select Symbols & Language from the menu panel.
3. Select the desired language in the Label Language drop-down menu.

Setuy

Symbol ibrares Symbol Presertation Orde
Wy Symbols ~] 1 SmboSve [ Cumom
[ PCS Classic: 2000 Addendum Classic

[ PCS Classc: Core- 2. fom: Person-Lke

1 PCS Soenes of | | BE&EE b
< 4. Sin Color: Larter Sen

T

Impor Boardnaker Lbvary

=

use a different language for your symbol searches, make a selection from the Search Language drop-down
menu.

The search language will automatically change to match the label language you have selected. If you want to
@ You can also access these settings from the | | Symbols & Language button in the Symbols panel.

9.3 Editing Symbols

With Boardmaker Studio, you can use the Symbol Editor to customize any symbol to suit your needs and preferences.
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1.

Right-click on the symbol you would like to customize, then choose Edit in Symbol Editor. The Symbol Editor window
will open.

Use the tools in the Symbol Editor toolbar to customize the symbol. See Figure 9.3 Symbol Editor Toolbar.
Select Save as New Symbol . The customized symbol is added to your symbol library.

E::}x B N « ® | ¢ O . &.

Select Faste Draw Fill Shape Erase Rotate Filters

006 00000 0 O

Figure 9.3 Symbol Editor Toolbar

1 Select Select an area of the symbol. Use the Marquee Tool panel to determine the shape of the area you are
selecting.

2 Cut Use the Cut tool to remove a selected area from the symbol and place it on the clipboard. Use the Copy
tool to add a copy of the selected area to the clipboard.

3 Paste Paste from the clipboard.

Draw Draw a freeform line on the symbol. Use the Paint Tool panel to customize the width and color of the line.
Fill Select a colored area in the symbol and all pixels of the same color (within a bounded area) will be filled
with a new color. Use the Fill Tool panel to customize the new color.
To fill every pixel of the same color in the symbol (ignoring bounded areas), deselect the Continuous
checkbox.

6 Shape Draw a new shape. Use the Shape Tool panel to select a specific shape and customize its color.

7 Erase Select the Erase tool to erase some of the symbol. Select the Erase Fill tool to erase all of a selected color
within a bounded area. (Deselect the Continuous check box to delete all pixels of the same color, regard-
less of boundaries.) Select the Erase Shape tool to draw a shape and erase everything within it. Use the
Erase Shape Tool panel to select a shape.

8 Rotate Change the position of the symbol by selecting the Flip Horizontal, Flip Vertical, Rotate Left or Rotate Right
tools.

9 Filters Add color filters to the symbol by selecting the following tools: Inverse, Gray, Sepia, Black & White, and
Polaroid.

Boardmaker Studio Getting Started v.1.0 - en-US 9 Working with Symbols | 27




10 Working with Message Windows

Message windows are primarily used to display or compose text. Buttons and other objects can be programmed with actions
that will send text, symbols, sound files, labels, etc. to the Message Window or control its behavior.

10.1 Create a Message Window

1.
2.

Select the Message Window tool in the toolbar.
Draw a Message Window anywhere on the page.

You can draw more than one Message Window on a page.

Select the Message Window. The Message Window Properties panel opens.
Use the controls in the Message Windows Properties panel to define the Message Window.
* Font properties — format the text that appears in the Message Window.

= Symbolate properties — choose whether symbols appear with text in the Message Window; define symbol loca-
tion, symbol size, and the types of words that will have symbols.

Only the main message window properties are covered here. See the Boardmaker Studio User's Guide for step-by-
instructions on defining all message window properties.

10.2 Format the Message Window Text

To format the text that appears in the message window.

1.
2.

Select Font in the properties panel.
Choose the attributes of the font:

= Type
=  Size

= Style
= Color

= Background color

10.3 Message Window Symbolate Properties

Use the controls in the Symbolate properties group to define symbol location, symbol height and width, and choose which
words in the message window text to symbolate.

Eal

Select Symbolate as the mode.

Select whether you want the symbol to be on top or on the bottom of the text.

Select the height of the symbols (in pixels).

Use the Symbolate drop-down menu to select which type of words you want to symbolate.

n See the Boardmaker Studio User's Guide for an explanation of Word Lists and Common Words.

Select the All Same Width check box to display each symbol at the same width.
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10.4 Miscellaneous Properties of Message Windows

Audio Cue

An Audio Cue is a short message that is played when the cursor or scanning highlight passes over an
object. If you do not wish to have an Audio Cue for the Message Window, leave the Audio Cue field
blank.

Save in Play Mode

When enabled, the contents of the Message Window are stored when Boardmaker Studio closes.
The next time the project is opened, the contents of the Message Window are automatically restored.

Response Type Define the behavior of the Message Window when it is selected:

= Speak — the current Message Window text is spoken.

= Move Cursor — place the cursor in the selected place in the text.

= Speak Word — the selected word is spoken.

= Show Symbol — display the symbol for the currently selected word.
Scroll Mode Define how the Message Window scrolls text:

= Line-by-line
= Page-by-page

Edit Mode(s)

Choose which software mode(s) permit text to be entered into the Message Window.

Spell Mode

Set the spell check preference for the Message Window:

= None — spell check is disabled.

= Show — misspelled words are underlined in red.

= Show and Suggest — underline misspelled words and show suggested replacements. (In De-
sign mode, right click the misspelled word to see suggestions.)
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11 Working with Labels

Use the Label tool to place text anywhere on a page. You can use a Label to put a title on a page or object, to give instructions,
or write a description or story. You can assign actions to a label, symbolate the label text, and more!

If you place a label on any type of button, the label retains its own properties; it does not become a part of the button.

11.1 Draw a Label

Select the A Label tool in the toolbar.
2. Draw the label bounding box on the page.
For more information, see 7 Drawing Page Objects, page 20.

—_

w

Type the desired label text.
Select the Label.
5. Use the controls in the Label Properties panel to define the properties of the label.

P

11.2 Add and Format the Label Text

Use the Rich Text Editor or the Rich Text Toolbar to further add and format the label text.

For more information, see section 72 Rich Text Editor, page 31.

11.3 Label Symbolate Properties

You can use symbols in your label text. Use the controls in the Symbolate properties group to set the symbol location, symbol
height and width, and choose which words in the label text to symbolate.

1. Select Yes in the Symbolate menu (Miscellaneous properties) to show symbols.

= Select the symbol location - above the text or below the text.
= Select the height of the symbols (in pixels).
= Use the Symbolate drop-down menu to select the type of words you want to symbolate.

See the Boardmaker Studio User's Guide for an explanation of Word Lists and Common Words.

= Select the All Same Width check box to display each symbol at the same width.

11.4 Set the Label Auto-Grow Properties

Use the Auto Grow drop-down menu in the Miscellaneous properties group to select the way the label text fits into the label
bounding box. Select None to manually resize the text, or select Width, Height, or Both (width and height) to automatically re-
size the bounding box to fit the text.

If Auto Grow is set to None, no visual indication will be provided if the text does not fit in the bounding box and is
@ therefore truncated.
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12 Rich Text Editor

Use the Rich Text Editor to add special formatting to the text you place on an object. The Rich Text Editor will open when you
select the Rich Text Editor button in the Content Properties group for an object.

Contert n
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Figure 12.1 Rich Text Editor Button In Content Properties Group

The Rich Text Editor contains standard text editing tools, such as font selection, size, color, alignment, etc. It also provides spe-
cial tools.

Edit  Insert a a

(F=Y | Tahoma

Figure 12.2 Rich Text Editor

1 Insert menu Insert a speech effect, pause, sound file, image, keyboard key, or expression into the text.

2 | Symbolate Symbolate the selected text.

3 | Speech style button Change speech settings for the selected text.

The Rich Text Toolbar is an abbreviated version of the Rich Text Editor (text is dynamically displayed on the object
being edited).

The Rich Text Toolbar allows you to edit text “on the fly” and will open automatically when you select text in a message
window, label, or on a standard or symbolate button.
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13 Working with Videos

Adding a video to a page can make your activities more engaging for students.

13.1 Create a Video Object

1. Use the Video Tool to draw a video object anywhere on the page.
For more information, see 7 Drawing Page Objects, page 20

Figure 13.1 Video Object

2. Select the video object. The Video Properties panel will open.
3. Use the controls in the Video Properties panel to define the properties of the video.

Only selecting a video and setting it to play are covered in this document. See the Boardmaker Studio User's Guide
for step-by-instructions on all of the properties of video objects.

13.1.1  Select the Video to Play

1. Click anywhere in the Content drop-down menu at the top of the Video Properties panel. A file browser will open.
2. Navigate to the folder on your computer that contains the .wmyv, .mp4, or .avi video you want to play, and select the
video.

The Boardmaker Studio software includes ten short, funny reward animations. The reward animations can be
@ found in C:\Users\Public\Documents\Boardmaker Studio Shared\Media\Videos

Select Open on the file browser. The title of the video you chose will appear in the Content drop-down menu.

3.
You can also drag a .wmv video file from outside the workspace and drop it into the video object.

13.1.2 Enable “Touch Video”

You can program a video to start playing by selecting Yes in the Touch Video dropdown menu (Miscellaneous Properties). The
video will play until it is finished or until the video object is selected again. (If you select No, the video must be triggered to play
by selecting another object programmed with the appropriate action.)

13.1.3  Enable “Repeat Video”

You can repeat the video indefinitely by selecting Yes in the Repeat Video drop-down menu (Miscellaneous properties). The
video will continue to replay until the video object is selected again. (If you select No, the video will play only once.)
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14 Changing an Object’s Style

You can customize the appearance of most objects. Use the Style and Style Override properties groups in the Properties panel
to change the object’s general style, shape, fill color, and border.

Style 3
Style Overide 2
(5] (2] (2]

Figure 14.1 Properties Panel — Style and Style Override groups

With some objects, such as pages and message windows, you are limited to changing the background color and the border
color, style, and thickness. With lines, you can only change the color, thickness, and style.

n No style options are available for hot spots, labels, SmartSyms, text boxes, or videos.

14.1 Change the Object’s Style

The style controls the overall appearance of the object. Each object can have its own style.

1. Select the Style drop-down menu.
2. Select a style for the object.

The page has a Theme property that applies coordinated styles to all of the objects on that page. It provides an easy
way to give your pages a consistent look and feel.
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14.2 Customize the Object’s Style

Use the Style Override drop-down menus - shape, fill color, and border - to customize the object’s style.

Use Default Shape

Shape Override Menu

Use Default Color
Mo Color

Meore Colors...

Gradient

Gradient Color

Fill Color Override Menu

n Style overrides are preserved if you change the page theme.

34 |14 Changing an Object's Style

Use Default Color

Mo Color

More Colors...

iy
— Thickness 3

o Style ]

Border Override Menu
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15 Working with Gadgets

A gadget is a pre-programmed object or collection of objects that enable you to quickly construct and enhance your activities.
Using gadgets, you can construct entire activities without having to program each object from scratch.

Types of Gadgets

Basics — Add buttons that are pre-programmed with common actions.

Draggable Buttons — Create activities using virtual manipulatives, such as grouping, matching, and sorting activities.
Fun Interactions — Create activities with animations, multimedia, and other effects.

Mathematics — Add interactive math objects such as calculators, spinners, counting bins, and more.

Navigation — Navigate to other pages, programs, files, and web sites.

Question and Answer — Add multiple choice questions to your activities.

Time — Display the current time or add a visual timer or stopwatch to any activity.

Writing — Design writing activities for your users.

You can create your own gadgets using an object or group of objects on a page. For more information, see the
Boardmaker Studio User's Guide.

15.1 Add a Gadget to the Page

Eal S

Select the 'f Gadgets button to display the Gadgets panel.

Double-click a category folder. The gadgets available in that category will be displayed.
Select a gadget and drag it onto the page.

If desired, resize or move the gadget.

n Be careful when resizing gadgets. Some gadgets will not work properly when resized.
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16 Working with Actions

It is very easy to program an object using Boardmaker Studio. “Programming” an object simply involves assigning actions to the
object using the Action Editor.

1.
2.

Select the object (or the page itself) to which you want to add actions. The Properties panel for that object will open.
Select the Edit Actions button in the Properties panel (Programming group). The Action Editor will open. Any actions
that are currently assigned to the object will be listed.

Double-click the object to open the Action Editor.

Select the action you want to add. You can:

= Search for an action. See section 16.3 Searching for Actions.
=  Select an action from the Action Category List. See section 16.2 Action Categories.
= Select an action from the Favorites or Snippets drop-down menus.

The action will be added to the action script.

If the action you have selected needs further information - for example, the name of a page to open or sound
to play - a menu or dialog will open. You must select the appropriate page to open, sound to play, etc., to com-
plete the action. The action will then be added to the action script.

Select Save to close the Action Editor.

16.1 Action Editor

Use the Action Editor to assign actions to an object or page, or to edit actions already assigned. You can add actions from a
number of categories, search for a specific action, reorder or delete actions, and add a favorite action or action “snippet”.

n A Snippet is a collection of actions that are frequently used together.

To access the Action Editor:

Select the Edit Actions button in the Properties panel of any programmable object or
Double-click directly on an object.
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Search text box

Enter your search criteria. As you type, action choices will be dynamically displayed.

2 Search button Enter a keyword in the Search text box and then select this button.

3 Favorites Displays a list of your favorite actions. (You can mark any action for inclusion on this list.)

4 Macros Add a macro to the object you are programming.

5 Snippets Add a commonly used grouping of actions (“snippet”) to the object you're programming.

6 Edit shared variables Add or edit a variable shared in a project, activity, or page.

7 Cut Cut the selected (highlighted) action(s).

8 Copy Copy the selected (highlighted) action(s).

9 Paste Paste the action(s) you have cut/copied (at the line indicated by the insertion cursor).

10 Delete Remove the selected (highlighted) action(s).

11 Move arrows Move selected (highlighted) lines up or down in the sequence of actions.

12 Options Open the Action Script Options dialog box (to help you customize the actions you
program).

13 Events Select an event to which you want to add actions (such as “Selected” or “PageOpen.”)

14 Execution types Designate when the actions programmed on two or more objects are executed.

15 Category list List of action categories, arranged by category group.

16 Insertion cursor Indicates the location in the list of actions where the next action will be added.

17 | Assigned actions list Displays all the actions assigned to the current object. (Actions are performed in the se-

quence in which they are listed.)
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16.2 Action Categories

Boardmaker Studio offers a large number of actions that you can assign to objects on a page (or to the page itself). You can
browse for actions using the category list in the Action Editor.

Actions are grouped into four categories:

= Screen Objects

= Appearance

= Programming

= Audio/Video/Speech

To browse for an action, select an action category, then select a subcategory. A menu will open, listing all of the actions in that
subcategory - with a brief description of each action. Select an action to add it to the action script for the object or page you
are programming.

16.3 Searching for Actions

If you don't know the name of the action you want to use, you can start typing a keyword into the Search text box on the Action
Editor. As you type, actions that match the text you have entered are dynamically displayed.

You can also type a keyword or two into the Search text box, and then select the Search button to open a list of ac-
tions that match your search criteria.

Some of the actions in the category list have variations. These are indicated by an ellipsis icon. Select the ellipsis icon to open a
list of variations of the selected action.

When you see the action you want to use, select it to add it to the assigned actions list for the object you are programming.

16.4 Favorite Actions

The Favorites list in the Action Editor contains a list of frequently used actions. Use this list to quickly add a favorite action when
you are programming an object.

To add a favorite action to an object you are programming:

1. Select the Favorites drop-down menu in the Action Editor toolbar. The Favorites list will open.
2. Select an action from the list. It will be added to the action script at the position indicated by the insertion cursor.

16.4.1 Customize the Favorite Actions List

You can customize the Favorites list by adding actions you use most

1. Search for the action that you want to add. See section 16.3 Searching for Actions.

2. Select the e Add icon to the left of the action to add it to the Favorites list. The icon will change to the =~ % star
icon, indicating that the action is now a favorite.
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